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Q.1 Two pipes M and N can fill a tank in 20 minutes and 25 minutes
respectively. Both the pipes are opened together but after 5
minutes, pipe M is turned off. What is the total time required to fill
the tank?5445

Ans A. 12 min 40 sec

B. 16 min 30 sec

C. 14 min 55 sec

D. 18 min 45 sec

Question Type : MCQ
Question ID : 441009898758
Option 1 ID : 4410093549102
Option 2 ID : 4410093549104
Option 3 ID : 4410093549103
Option 4 ID : 4410093549105

Status : Answered
Chosen Option : D

Q.2 A sum of ₹6100 grows to ₹9040 in 2 years at simple interest. What is the total interest
earned in 2 years (in ₹)?

Ans A. 2940

B. 2890

C. 3040

D. 3090

Question Type : MCQ
Question ID : 441009853090
Option 1 ID : 4410093365332
Option 2 ID : 4410093365334
Option 3 ID : 4410093365333
Option 4 ID : 4410093365335

Status : Answered
Chosen Option : A

Q.3 A person sells two articles at the same price. On one he gains 10% and on the other he
loses 10%. His profit or loss percentage on whole transaction is:

Ans A. Profit of 1%

B. Profit of 2%

C. Loss of 2%

D. Loss of 1%

Question Type : MCQ
Question ID : 4410091428659
Option 1 ID : 4410095643164
Option 2 ID : 4410095643166
Option 3 ID : 4410095643165
Option 4 ID : 4410095643163

Status : Answered
Chosen Option : D
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Q.4 Three parallel line segments PQ, MN, and AB are drawn such that PQ is parallel to MN
and MN is parallel to AB. The lengths of PQ and AB are 40 cm and 60 cm, respectively.
Two transversals intersect these parallel segments: one passes through points P, M,
and A, and the other passes through points Q, N, and B. On the transversal through P,
M, and A, the point M divides the segment PA in the ratio 5 : 7. Find the length of MN.

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009603199
Option 1 ID : 4410092367915
Option 2 ID : 4410092367913
Option 3 ID : 4410092367916
Option 4 ID : 4410092367914

Status : Not Answered
Chosen Option : --

Q.5 X and Y start a business by investing ₹60,000 and ₹80,000, respectively. After 6 months,
X adds ₹40,000 to his investment. If the profit at the end of the year is ₹1,50,000, find
the share of each partner.

4332

Ans A. X=₹72,000 and Y= ₹78000

B. X= ₹80,000 and Y= ₹70000

C. X= Y= ₹75000

D. X=₹70,000 and Y= ₹80000

Question Type : MCQ
Question ID : 441009897645
Option 1 ID : 4410093544652
Option 2 ID : 4410093544650
Option 3 ID : 4410093544653
Option 4 ID : 4410093544651

Status : Answered
Chosen Option : C

Q.6 For 8 innings, Nitish scored an average of 60 runs. In the 9th inning, he scored 150
runs. What is his new average (in runs)?

Ans A. 69

B. 70

C. 67

D. 68

Question Type : MCQ
Question ID : 441009750499
Option 1 ID : 4410092955867
Option 2 ID : 4410092955866
Option 3 ID : 4410092955864
Option 4 ID : 4410092955865

Status : Answered
Chosen Option : B
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Q.7 A completes 60% of a work in 12 days. He then calls in B and they together finish the
remaining work in 2 days. How long B alone would take to complete the whole work?

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009217185
Option 1 ID : 441009852785
Option 2 ID : 441009852788
Option 3 ID : 441009852787
Option 4 ID : 441009852786

Status : Answered
Chosen Option : C

Q.8 A shopkeeper sells an item for ₹197.6 after giving two successive discounts of 80% and
20% on its marked price. Had he not given any discount, he would have earned a profit
of 90%. What is the cost price (in ₹) of the item?

Ans A. 650

B. 687

C. 680

D. 632

Question Type : MCQ
Question ID : 441009915802
Option 1 ID : 4410093617459
Option 2 ID : 4410093617460
Option 3 ID : 4410093617462
Option 4 ID : 4410093617461

Status : Answered
Chosen Option : C

Q.9 If Aftab travels with a speed of 20 km/hr, he reaches his destination at 9:30 pm
while if he travels with a speed of 35 km/hr, he reaches the same destination at
3:30 pm. At what speed must he travel to reach the same destination at 5:30 pm?

Ans A. 24 km/hr

B. 25 km/hr

C. 32 km/hr

D. 28 km/hr

Question Type : MCQ
Question ID : 4410091224390
Option 1 ID : 4410094831046
Option 2 ID : 4410094831045
Option 3 ID : 4410094831043
Option 4 ID : 4410094831044

Status : Answered
Chosen Option : C
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 

Q.1
0

5551

Ans A. 70

B. 42

C. 43

D. 60

Question Type : MCQ
Question ID : 441009898864
Option 1 ID : 4410093549527
Option 2 ID : 4410093549529
Option 3 ID : 4410093549528
Option 4 ID : 4410093549526

Status : Answered
Chosen Option : D

Q.1
1

Find the number of prime factors contained in the product 349 × 256 × 4213.

Ans A. 18

B. 42

C. 28

D. 69

Question Type : MCQ
Question ID : 441009273113
Option 1 ID : 4410091060999
Option 2 ID : 4410091061000
Option 3 ID : 4410091061001
Option 4 ID : 4410091061002

Status : Not Answered
Chosen Option : --

Q.1
2

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 4410091441369
Option 1 ID : 4410095694126
Option 2 ID : 4410095694125
Option 3 ID : 4410095694123
Option 4 ID : 4410095694124

Status : Answered
Chosen Option : A
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Q.1
3

A farmer sells two types of produce: apples and oranges. The price per basket of
apples is ₹120, and the price per basket of oranges is ₹180. On a particular day, the
farmer sold a total of 200 baskets, and the total revenue from the sale of apples and
oranges was ₹30,000. What is the number of baskets of apples and oranges sold?

Ans A. 120 apples and 80 oranges

B. 100 apples and 100 oranges

C. 150 apples and 50 oranges

D. 80 apples and 120 oranges

Question Type : MCQ
Question ID : 441009212059
Option 1 ID : 441009832641
Option 2 ID : 441009832642
Option 3 ID : 441009832643
Option 4 ID : 441009832644

Status : Answered
Chosen Option : B

 

Q.1
4

Ans A. 4455 m3

B. 4621 m3

C. 4292 m3

D. 4185 m3

Question Type : MCQ
Question ID : 441009274531
Option 1 ID : 4410091066416
Option 2 ID : 4410091066417
Option 3 ID : 4410091066415
Option 4 ID : 4410091066414

Status : Answered
Chosen Option : A

Q.1
5

In a symmetrical distribution, the mean is 15. Find the value of 3(median) – (mode).

Ans A. 45

B. 0

C. 15

D. 30

Question Type : MCQ
Question ID : 4410091822750
Option 1 ID : 4410097185826
Option 2 ID : 4410097185827
Option 3 ID : 4410097185824
Option 4 ID : 4410097185825

Status : Answered
Chosen Option : D
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Q.1
6

Given that 1480.27 = x, 1480.51 = y, and xz = y6, the value of z is:0

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009560451
Option 1 ID : 4410092197071
Option 2 ID : 4410092197072
Option 3 ID : 4410092197073
Option 4 ID : 4410092197074

Status : Not Answered
Chosen Option : --

Q.1
7

Manoj had ₹1,612, which he divided between his sons Anand and Anil, asking them to
invest their shares at a compound interest rate of 8% per annum, compounded
annually. It was observed that Anand and Anil ended up with equal amounts after 13
and 14 years respectively. How much did (in ₹) Manoj initially give to Anand?

Ans A. 775

B. 875

C. 837

D. 687

Question Type : MCQ
Question ID : 441009897832
Option 1 ID : 4410093545399
Option 2 ID : 4410093545401
Option 3 ID : 4410093545398
Option 4 ID : 4410093545400

Status : Answered
Chosen Option : D

Q.1
8

Ravi earns ₹8,000 per month and spends 75% of his income. How much money does he
spend each month?

Ans A. ₹7,200

B. ₹7,000

C. ₹6,000

D. ₹6,500

Question Type : MCQ
Question ID : 4410091623050
Option 1 ID : 4410096410947
Option 2 ID : 4410096410946
Option 3 ID : 4410096410944
Option 4 ID : 4410096410945

Status : Answered
Chosen Option : C
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Q.1
9

Subtracting 23% of X from X is the same as multiplying X by:

Ans A. 0.5

B. 0.77

C. 0.23

D. 0.023

Question Type : MCQ
Question ID : 441009857512
Option 1 ID : 4410093383022
Option 2 ID : 4410093383020
Option 3 ID : 4410093383021
Option 4 ID : 4410093383023

Status : Answered
Chosen Option : C

 

Q.2
0

Ans A. 16

B. 17

C. 18

D. 19

Question Type : MCQ
Question ID : 441009201390
Option 1 ID : 441009792720
Option 2 ID : 441009792721
Option 3 ID : 441009792722
Option 4 ID : 441009792723

Status : Not Answered
Chosen Option : --

Q.2
1

In the Padma Awards 2026, Shri S K M Maeilanandhan was announced the recipient of
the Padma Bhushan under which category of service?

Ans A. Science and Engineering

B. Social Work

C. Literature and Education

D. Sports

Question Type : MCQ
Question ID : 4410091827193
Option 1 ID : 4410097202862
Option 2 ID : 4410097202864
Option 3 ID : 4410097202861
Option 4 ID : 4410097202863

Status : Answered
Chosen Option : C

Section : General Studies
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Q.2
2

Which of the following leaders is not related to 'Utkala Sammilani', formed to initiate the
movement for a separate Odia state?

Ans A. Biju Patnaik

B. V. K. Krishna Menon

C. Madhusudan Das

D. Harekrushna Mahatab

Question Type : MCQ
Question ID : 4410091424194
Option 1 ID : 4410095625592
Option 2 ID : 4410095625593
Option 3 ID : 4410095625590
Option 4 ID : 4410095625591

Status : Answered
Chosen Option : A

Q.2
3

A sound wave has a frequency of 4 kHz and a wavelength of 15 cm. How much time will
it take to travel a distance of 4.2 km?

Ans A. 700 s

B. 70 s

C. 7 s

D. 0.7 s

Question Type : MCQ
Question ID : 4410091445281
Option 1 ID : 4410095709700
Option 2 ID : 4410095709699
Option 3 ID : 4410095709697
Option 4 ID : 4410095709698

Status : Not Answered
Chosen Option : --

Q.2
4

In 2026, The 11th edition of which global forum continued to serve as a platform for
dialogue on geopolitics, security, and strategic affairs, with participation from
policymakers and experts worldwide?

Ans A. Raisina Dialogue

B. G7 Summit

C. BRICS Summit

D. World Economic Forum

Question Type : MCQ
Question ID : 4410091840833
Option 1 ID : 4410097256550
Option 2 ID : 4410097256551
Option 3 ID : 4410097256552
Option 4 ID : 4410097256549

Status : Answered
Chosen Option : D
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Q.2
5

Which edition of Kalinga Literary Festival was held in Odisha in 2026?

Ans A. 22nd

B. 12th

C. 17th

D. 7th

Question Type : MCQ
Question ID : 4410091863082
Option 1 ID : 4410097342529
Option 2 ID : 4410097342526
Option 3 ID : 4410097342528
Option 4 ID : 4410097342527

Status : Answered
Chosen Option : D

Q.2
6

Who among the following was a prominent Odia leader in the Non-Cooperation
Movement in the Balasore district presently at Bhadrak in Odisha?

Ans A. Nilakantha Das

B. Biju Patnaik

C. Gopabandhu Das

D. Harekrushna Mahtab

Question Type : MCQ
Question ID : 441009641255
Option 1 ID : 4410092519157
Option 2 ID : 4410092519158
Option 3 ID : 4410092519155
Option 4 ID : 4410092519156

Status : Answered
Chosen Option : A

Q.2
7

Prof. (Dr.) Lars‑Christian Koch, a German national, was announced for the Padma Shri
2026 award by India for contributions to which field?

Ans A. Trade and Industry

B. Science and Engineering

C. Literature and Education

D. Art

Question Type : MCQ
Question ID : 4410091861970
Option 1 ID : 4410097338125
Option 2 ID : 4410097338123
Option 3 ID : 4410097338124
Option 4 ID : 4410097338122

Status : Not Attempted and
Marked For Review

Chosen Option : --
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Q.2
8

The Act that ended the rule of the East India Company was passed in:

Ans A. 1858

B. 1857

C. 1856

D. 1860

Question Type : MCQ
Question ID : 441009966349
Option 1 ID : 4410093818598
Option 2 ID : 4410093818597
Option 3 ID : 4410093818596
Option 4 ID : 4410093818599

Status : Answered
Chosen Option : A

Q.2
9

Which of the following architectural features distinguishes Dravida style temples from
Nagara style temples?

Ans A. Use of marble

B. Use of rock-cut caves

C. Presence of gopurams

D. Use of arches and domes

Question Type : MCQ
Question ID : 4410091046181
Option 1 ID : 4410094133785
Option 2 ID : 4410094133788
Option 3 ID : 4410094133786
Option 4 ID : 4410094133787

Status : Not Answered
Chosen Option : --

Q.3
0

In Hinduism, the concept of dharma is an important principle that guides the behaviour
of individuals in society. What does the concept of dharma mainly refer to?

Ans A. Accumulation of wealth and property

B. Worship of gods and temple rituals

C. Performance of sacrifices and rituals

D. Duties according to caste, age and gender

Question Type : MCQ
Question ID : 441009866523
Option 1 ID : 4410093419127
Option 2 ID : 4410093419125
Option 3 ID : 4410093419126
Option 4 ID : 4410093419124

Status : Answered
Chosen Option : B
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Q.3
1

The Right to equality is given in the which Article of the of the Indian Constitution?

Ans A. 16–20

B. 15–19

C. 14–18

D. 17–21

Question Type : MCQ
Question ID : 441009870521
Option 1 ID : 4410093435038
Option 2 ID : 4410093435037
Option 3 ID : 4410093435036
Option 4 ID : 4410093435039

Status : Answered
Chosen Option : C

Q.3
2

Which type of soil covers the largest area in the state of Odisha?

Ans A. Black soil

B. Alluvial soil

C. Red soil

D. Laterite soil

Question Type : MCQ
Question ID : 4410091337467
Option 1 ID : 4410095281795
Option 2 ID : 4410095281797
Option 3 ID : 4410095281798
Option 4 ID : 4410095281796

Status : Answered
Chosen Option : A

Q.3
3

Which among the following sand dune formations is commonly observed in the Great
Indian Desert?

Ans A. Eskers

B. Cirques

C. Barchans

D. Loess terraces

Question Type : MCQ
Question ID : 4410091015468
Option 1 ID : 4410094013393
Option 2 ID : 4410094013392
Option 3 ID : 4410094013394
Option 4 ID : 4410094013395

Status : Not Answered
Chosen Option : --
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Q.3
4

What is the main advantage of using organic manure over chemical fertilizers in crop
production?

Ans A. Chemical fertilizers improve soil health permanently

B. Organic manure provides immediately available nutrients but depletes soil structure

C. Organic manure reduces the need for irrigation

D. Organic manure improves soil texture and provides nutrients gradually

Question Type : MCQ
Question ID : 4410091443582
Option 1 ID : 4410095702852
Option 2 ID : 4410095702850
Option 3 ID : 4410095702853
Option 4 ID : 4410095702851

Status : Answered
Chosen Option : C

Q.3
5

In which of the following years did the Quit India Movement start?

Ans A. 1943

B. 1939

C. 1945

D. 1942

Question Type : MCQ
Question ID : 441009963063
Option 1 ID : 4410093805619
Option 2 ID : 4410093805620
Option 3 ID : 4410093805618
Option 4 ID : 4410093805621

Status : Answered
Chosen Option : D

Q.3
6

Which of the following is NOT correct regarding preventive detention?

Ans A. It is dealt under Article 22 of Constitution of India.

B. The detained person should be produced before a magistrate within 24 hours,
excluding the journey time.

C. A person may be taken to preventive custody only for one month.

D. The grounds of detention should be communicated to the detenu.

Question Type : MCQ
Question ID : 44100945575
Option 1 ID : 441009181487
Option 2 ID : 441009181489
Option 3 ID : 441009181488
Option 4 ID : 441009181490

Status : Answered
Chosen Option : C
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Q.3
7

Which of the following gas is used in the manufacture of bleaching powder?

Ans A. Hydrogen gas

B. Sulphur gas

C. Chlorine gas

D. Nitrogen gas

Question Type : MCQ
Question ID : 4410091432229
Option 1 ID : 4410095657251
Option 2 ID : 4410095657253
Option 3 ID : 4410095657250
Option 4 ID : 4410095657252

Status : Answered
Chosen Option : D

Q.3
8

Which of the following statements best describes how parental or guardian consent is
managed for Human Papillomavirus (HPV) vaccination under the national programme?

Ans A. Consent is exclusively collected at houses by paper forms

B. Consent is obtained solely via the e-VIN portal

C. Consent is only verbal and not recorded

D. Consent is recorded digitally on U-WIN or in hard copy where internet is unavailable

Question Type : MCQ
Question ID : 4410091835176
Option 1 ID : 4410097234518
Option 2 ID : 4410097234519
Option 3 ID : 4410097234517
Option 4 ID : 4410097234516

Status : Not Answered
Chosen Option : --

Q.3
9

What is the primary purpose of the National Bank for Agriculture and Rural
Development (NABARD), established in 1982?

Ans A. Supervising and coordinating rural credit and development activities

B. Enhancing agricultural production through irrigation development schemes

C. Providing housing support and basic amenities in rural areas

D. Promoting rural employment through wage-based livelihood programmes

Question Type : MCQ
Question ID : 441009869009
Option 1 ID : 4410093429067
Option 2 ID : 4410093429070
Option 3 ID : 4410093429069
Option 4 ID : 4410093429068

Status : Answered
Chosen Option : A
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Q.4
0

Which noted advocate of the Santali language and promoter of tribal education from
Odisha was announced the recipient of Padma Shri 2026 in the field of Literature and
Education?

Ans A. Mayadhar Mansingh

B. Haldhar Nag

C. Charan Hembram

D. Pratibha Ray

Question Type : MCQ
Question ID : 4410091864440
Option 1 ID : 4410097347106
Option 2 ID : 4410097347105
Option 3 ID : 4410097347107
Option 4 ID : 4410097347104

Status : Answered
Chosen Option : C

Q.4
1

Which among the following countries lies along the coast of the Red Sea?

Ans A. China

B. Brazil

C. India

D. Saudi Arabia

Question Type : MCQ
Question ID : 4410091843736
Option 1 ID : 4410097267888
Option 2 ID : 4410097267886
Option 3 ID : 4410097267887
Option 4 ID : 4410097267885

Status : Answered
Chosen Option : D

Q.4
2

What is the alternative name for Satkosia Tiger Reserve in Odisha?

Ans A. Satkosia Plateau Wildlife Sanctuary

B. Satkosia Gorge Wildlife Sanctuary

C. Satkosia Hilltop Wildlife Sanctuary

D. Satkosia Delta Wildlife Sanctuary

Question Type : MCQ
Question ID : 441009642557
Option 1 ID : 4410092524372
Option 2 ID : 4410092524373
Option 3 ID : 4410092524371
Option 4 ID : 4410092524374

Status : Answered
Chosen Option : B
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Q.4
3

Which of the following classical dance forms originated in Andhra Pradesh?

Ans A. Mohiniyattam

B. Bharatanatyam

C. Kathak

D. Kuchipudi 

Question Type : MCQ
Question ID : 441009609179
Option 1 ID : 4410092391836
Option 2 ID : 4410092391835
Option 3 ID : 4410092391834
Option 4 ID : 4410092391833

Status : Answered
Chosen Option : D

Q.4
4

Which source of energy uses the heat from the interior of the Earth to generate
electricity?

Ans A. Tidal energy

B. Geo-thermal energy

C. Biogas

D. Atomic energy

Question Type : MCQ
Question ID : 44100956991
Option 1 ID : 441009226772
Option 2 ID : 441009226773
Option 3 ID : 441009226774
Option 4 ID : 441009226775

Status : Answered
Chosen Option : B

Q.4
5

Which Schedule of the Indian Constitution provides for the allocation of seats in the
Council of States?

Ans A. Fourth Schedule

B. Third Schedule

C. Sixth Schedule

D. Fifth Schedule

Question Type : MCQ
Question ID : 441009323340
Option 1 ID : 4410091259531
Option 2 ID : 4410091259530
Option 3 ID : 4410091259533
Option 4 ID : 4410091259532

Status : Answered
Chosen Option : A

Section : English
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Q.4
6

Choose the correct one-word substitution for the highlighted segment.
He lives like a/an person who avoids human society.

Ans A. introvert

B. outsider

C. loner

D. hermit

Question Type : MCQ
Question ID : 4410091825665
Option 1 ID : 4410097196946
Option 2 ID : 4410097196949
Option 3 ID : 4410097196947
Option 4 ID : 4410097196948

Status : Answered
Chosen Option : A

Q.4
7

Select the option that can be used as a one-word substitute for the underlined group of
words.

The play started with a/an short introduction at the beginning.

Ans A. epilogue

B. prologue

C. espionage

D. sedition

Question Type : MCQ
Question ID : 441009331806
Option 1 ID : 4410091293283
Option 2 ID : 4410091293282
Option 3 ID : 4410091293284
Option 4 ID : 4410091293285

Status : Not Answered
Chosen Option : --

Q.4
8

Select the most appropriate meaning of the given idiom.
Shoot the breeze

Ans A. To plan carefully for tasks that must be completed soon

B. To argue seriously about topics that need urgent attention

C. To remain quiet and avoid speaking to anyone around

D. To spend time talking about things that are not important

Question Type : MCQ
Question ID : 441009411321
Option 1 ID : 4410091610676
Option 2 ID : 4410091610675
Option 3 ID : 4410091610677
Option 4 ID : 4410091610674

Status : Not Answered
Chosen Option : --

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.4
9

Complete the given sentence by selecting the most appropriate synonym of word given
in the bracket.
Her explanation was ____ (lucid) and easy to understand.

Ans A. confusing

B. obscure

C. clear

D. vague

Question Type : MCQ
Question ID : 4410091822959
Option 1 ID : 4410097186658
Option 2 ID : 4410097186657
Option 3 ID : 4410097186656
Option 4 ID : 4410097186659

Status : Answered
Chosen Option : C

Q.5
0

Select the option which can be used as a one-word substitute for the group of
highlighted words.
During the book fair, a person who loves books is often the first to explore every
stall and every new release.

Ans A. bibliophile

B. bibliographer

C. philanthropist

D. librarian

Question Type : MCQ
Question ID : 4410091825196
Option 1 ID : 4410097195098
Option 2 ID : 4410097195096
Option 3 ID : 4410097195097
Option 4 ID : 4410097195095

Status : Answered
Chosen Option : B

Q.5
1

In the given question, a statement divided into different segments is given. The first
segment (A) is fixed. Rearrange the other segments to form a coherent statement.
During the final match, (A) / led the team to (P) / their strongest rivals (Q) / the captain’s
brilliant strategy (R) / a memorable victory against (S)

Ans A. ASQPR

B. AQPSR

C. ARPSQ

D. APQRS

Question Type : MCQ
Question ID : 4410091787473
Option 1 ID : 4410097048493
Option 2 ID : 4410097048492
Option 3 ID : 4410097048491
Option 4 ID : 4410097048490

Status : Answered
Chosen Option : B
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Q.5
2

Select the synonym of the highlighted word.
Her benevolent actions towards the less fortunate were widely praised by the
community.

Ans A. kind

B. hostile

C. subtle

D. indifferent

Question Type : MCQ
Question ID : 4410091823333
Option 1 ID : 4410097188121
Option 2 ID : 4410097188120
Option 3 ID : 4410097188123
Option 4 ID : 4410097188122

Status : Not Answered
Chosen Option : --

Q.5
3

The following sentence has been divided into four segments. Identify the segment that
contains an error.
The report focused around the /effects of climate change on /the agriculture sector
throughout the /region over the last decade.

Ans A. The report focused around the

B. the agriculture sector throughout the

C. region over the last decade.

D. effects of climate change on

Question Type : MCQ
Question ID : 4410091827787
Option 1 ID : 4410097205248
Option 2 ID : 4410097205250
Option 3 ID : 4410097205251
Option 4 ID : 4410097205249

Status : Answered
Chosen Option : D

Q.5
4

Select the most appropriate option that rectifies the grammatical error(s) in the given
sentence.

The children was playing in the garden when it started raining.

Ans A. The children were playing in the garden when it started raining.

B. The children will playing in the garden when it started raining.

C. The children is playing in the garden when it started raining.

D. The children has playing in the garden when it started raining.

Question Type : MCQ
Question ID : 441009927579
Option 1 ID : 4410093664350
Option 2 ID : 4410093664352
Option 3 ID : 4410093664351
Option 4 ID : 4410093664353

Status : Answered
Chosen Option : D
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Q.5
5

In the following question a statement has been given with highlighted text. You are
required to replace
the text with correct Idiom given in the options.

Even though he had little preparation, Ramesh succeeded in his first attempt - by a
very narrow margin.

Ans A. By the skin of his teeth

B. Breaking the ice

C. Crying over spilt milk

D. Barking up the wrong tree

Question Type : MCQ
Question ID : 4410091400712
Option 1 ID : 4410095532512
Option 2 ID : 4410095532514
Option 3 ID : 4410095532515
Option 4 ID : 4410095532513

Status : Answered
Chosen Option : A

Q.5
6

Select the option that identifies the error in the given sentence and its correct
replacement.

My mother assisted me in preparing dinner, after which I completed a few assignments,
organizing the following day’s work, and went to sleep.

Ans A. Replace “after which I completed a few” with “after which I completing a few”

B. Replace “and went to sleep” with “and had went to sleep”

C. Replace “organizing the following day’s work” with “organized the following day’s
work”

D. Replace “My mother assisted me” with “My mother assists me”

Question Type : MCQ
Question ID : 4410091833259
Option 1 ID : 4410097227025
Option 2 ID : 4410097227027
Option 3 ID : 4410097227026
Option 4 ID : 4410097227024

Status : Not Answered
Chosen Option : --

Q.5
7

Choose the sentences in indirect speech from the list given below.

1. He said, “I am going to the library.”
2. She said that she was tired.
3. “We are ready to begin,” they said.
4. Rahul mentioned that he had called her.

Ans A. Statements 1 and 2 are in indirect speech.

B. Statements 3 and 4 are in indirect speech.

C. Statements 2 and 4 are in indirect speech.

D. Statements 1 and 3 are in indirect speech.

Question Type : MCQ
Question ID : 4410091206276
Option 1 ID : 4410094758639
Option 2 ID : 4410094758640
Option 3 ID : 4410094758638
Option 4 ID : 4410094758641

Status : Answered
Chosen Option : C
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Q.5
8

Select the option that identifies the error in the given sentence and corrects it.

I shall be mastered the art of communication through various mediums, one of which is
having dinner table conversations with my family.

Ans A. I shall have mastered the art of communication through various mediums, one of
which will be having dinner table conversations with my family.

B. I shall been mastered the art of communication through various mediums, one of
which is having dinner table conversations with my family.

C. I shall have being mastered the art of communication through various mediums, one
of which is having dinner table conversations with my family.

D. I shall mastered the art of communication through various mediums, one of which will
be having dinner table conversations with my family.

Question Type : MCQ
Question ID : 441009533260
Option 1 ID : 4410092088446
Option 2 ID : 4410092088444
Option 3 ID : 4410092088445
Option 4 ID : 4410092088447

Status : Answered
Chosen Option : A

Q.5
9

Select the option that identifies the error in the sentence and its correct replacement.

Until now, he had hardly made any mistakes; yet he carefully examined each paper
before the final submission. Imprecisely, there were still minor mistakes.

Ans A. Replace “he had hardly made” with “he had evenly made”

B. Replace “still minor mistakes” with “almost minor mistakes”

C. Replace “yet he carefully examined” with “yet he careful examined”

D. Replace “Imprecisely, there were” with “Unfortunately, there were”

Question Type : MCQ
Question ID : 4410091827859
Option 1 ID : 4410097205608
Option 2 ID : 4410097205611
Option 3 ID : 4410097205609
Option 4 ID : 4410097205610

Status : Not Answered
Chosen Option : --

Q.6
0

Identify the sentence that correctly uses passive voice.

Ans A. The new policy expected to be implemented by the government next year.

B. The new policy is expected to be implemented by the government next year.

C. The government is expected implementing the new policy next year.

D. The new policy is expected to implement by the government next year.

Question Type : MCQ
Question ID : 4410091831918
Option 1 ID : 4410097221710
Option 2 ID : 4410097221708
Option 3 ID : 4410097221709
Option 4 ID : 4410097221707

Status : Answered
Chosen Option : B
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Comprehension:

Read the following passage and answer the questions that follow.

In Stephen Crane’s story 'A Dark Brown Dog', a poor young boy finds a neglected, loyal dog
wandering the streets. Despite the dog’s gentle nature, the boy’s abusive father punishes the
dog for minor mischief. The boy secretly befriends the animal, sharing scraps of food and
showing affection. However, the dog’s loyalty and love are constantly tested by the cruelty of
humans around him. As the dog grows, the neighbourhood children mock and harm him, yet
he remains faithful to the boy. Through the story, Crane highlights the stark contrast between
innocence and brutality, showing how kindness can flourish even in harsh circumstances. The
dog’s quiet endurance becomes a symbol of loyalty and the suffering caused by human
indifference. The story evokes both sympathy for the animal and criticism of societal cruelty.

SubQuestion No : 61

Q.6
1

Who first befriends the dark brown dog?

Ans A. The neighbourhood children

B. The father

C. The dog’s owner

D. The boy

Question Type : MCQ
Question ID : 4410091493385
Option 1 ID : 4410095899180
Option 2 ID : 4410095899182
Option 3 ID : 4410095899183
Option 4 ID : 4410095899181

Status : Answered
Chosen Option : D

Comprehension:

Read the following passage and answer the questions that follow.

In Stephen Crane’s story 'A Dark Brown Dog', a poor young boy finds a neglected, loyal dog
wandering the streets. Despite the dog’s gentle nature, the boy’s abusive father punishes the
dog for minor mischief. The boy secretly befriends the animal, sharing scraps of food and
showing affection. However, the dog’s loyalty and love are constantly tested by the cruelty of
humans around him. As the dog grows, the neighbourhood children mock and harm him, yet
he remains faithful to the boy. Through the story, Crane highlights the stark contrast between
innocence and brutality, showing how kindness can flourish even in harsh circumstances. The
dog’s quiet endurance becomes a symbol of loyalty and the suffering caused by human
indifference. The story evokes both sympathy for the animal and criticism of societal cruelty.

SubQuestion No : 62

Q.6
2

What does the dog symbolize in the story?

Ans A. Fear and anxiety

B. Mischief and humorous attitude

C. Loyalty and innocence

D. Cruelty

Question Type : MCQ
Question ID : 4410091493386
Option 1 ID : 4410095899185
Option 2 ID : 4410095899187
Option 3 ID : 4410095899186
Option 4 ID : 4410095899184

Status : Answered
Chosen Option : C
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Comprehension:

Read the following passage and answer the questions that follow.

In Stephen Crane’s story 'A Dark Brown Dog', a poor young boy finds a neglected, loyal dog
wandering the streets. Despite the dog’s gentle nature, the boy’s abusive father punishes the
dog for minor mischief. The boy secretly befriends the animal, sharing scraps of food and
showing affection. However, the dog’s loyalty and love are constantly tested by the cruelty of
humans around him. As the dog grows, the neighbourhood children mock and harm him, yet
he remains faithful to the boy. Through the story, Crane highlights the stark contrast between
innocence and brutality, showing how kindness can flourish even in harsh circumstances. The
dog’s quiet endurance becomes a symbol of loyalty and the suffering caused by human
indifference. The story evokes both sympathy for the animal and criticism of societal cruelty.

SubQuestion No : 63

Q.6
3

What does “neglected” most nearly mean in the passage?

Ans A. Loved and cared for

B. Playful and active

C. Ignored and abandoned

D. Angry and ferocious

Question Type : MCQ
Question ID : 4410091493387
Option 1 ID : 4410095899189
Option 2 ID : 4410095899190
Option 3 ID : 4410095899188
Option 4 ID : 4410095899191

Status : Answered
Chosen Option : C

Comprehension:

Read the following passage and answer the questions that follow.

In Stephen Crane’s story 'A Dark Brown Dog', a poor young boy finds a neglected, loyal dog
wandering the streets. Despite the dog’s gentle nature, the boy’s abusive father punishes the
dog for minor mischief. The boy secretly befriends the animal, sharing scraps of food and
showing affection. However, the dog’s loyalty and love are constantly tested by the cruelty of
humans around him. As the dog grows, the neighbourhood children mock and harm him, yet
he remains faithful to the boy. Through the story, Crane highlights the stark contrast between
innocence and brutality, showing how kindness can flourish even in harsh circumstances. The
dog’s quiet endurance becomes a symbol of loyalty and the suffering caused by human
indifference. The story evokes both sympathy for the animal and criticism of societal cruelty.

SubQuestion No : 64

Q.6
4

What is the tone of the passage?

Ans A. Indifferent

B. Critical and sympathetic

C. Humorous

D. Excited and adventurous

Question Type : MCQ
Question ID : 4410091493388
Option 1 ID : 4410095899195
Option 2 ID : 4410095899193
Option 3 ID : 4410095899192
Option 4 ID : 4410095899194

Status : Answered
Chosen Option : B
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Comprehension:

Read the following passage and answer the questions that follow.

In Stephen Crane’s story 'A Dark Brown Dog', a poor young boy finds a neglected, loyal dog
wandering the streets. Despite the dog’s gentle nature, the boy’s abusive father punishes the
dog for minor mischief. The boy secretly befriends the animal, sharing scraps of food and
showing affection. However, the dog’s loyalty and love are constantly tested by the cruelty of
humans around him. As the dog grows, the neighbourhood children mock and harm him, yet
he remains faithful to the boy. Through the story, Crane highlights the stark contrast between
innocence and brutality, showing how kindness can flourish even in harsh circumstances. The
dog’s quiet endurance becomes a symbol of loyalty and the suffering caused by human
indifference. The story evokes both sympathy for the animal and criticism of societal cruelty.

SubQuestion No : 65

Q.6
5

Which best summarizes the passage?

Ans A. A loyal dog suffers cruelty but remains devoted to a kind boy.

B. A boy trains a dog to perform tricks for neighbours.

C. Children play with a friendly dog in the streets.

D. A dog protects the boy from the abusive father.

Question Type : MCQ
Question ID : 4410091493389
Option 1 ID : 4410095899199
Option 2 ID : 4410095899196
Option 3 ID : 4410095899197
Option 4 ID : 4410095899198

Status : Answered
Chosen Option : A

Q.6
6

ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

The children are dancing happily during the school annual function.

Ans A. ସ୍କୁ ଲ ବାର୍ଷିକ ଉତ୍ସବରେ ପିଲାମାନେ ନାଚିବେ।

B. ସ୍କୁ ଲ ବାର୍ଷିକ ଉତ୍ସବରେ ପିଲାମାନେ ଖୁସିରେ ନାଚୁ ଛନ୍ତି।

C. ସ୍କୁ ଲ ବାର୍ଷିକ ଉତ୍ସବରେ ପିଲାମାନେ ଖୁସିରେ ଖେଳୁଛନ୍ତି।

D. ସ୍କୁ ଲ ବାର୍ଷିକ ଉତ୍ସବରେ ଶିକ୍ଷକମାନେ ଖୁସିରେ ଖେଳୁଛନ୍ତି।

Question Type : MCQ
Question ID : 4410091135128
Option 1 ID : 4410094475789
Option 2 ID : 4410094475788
Option 3 ID : 4410094475787
Option 4 ID : 4410094475790

Status : Answered
Chosen Option : B

Section : Odia
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Q.6
7

‘କାନ’ର ତତ୍ସମ ଶବ୍ଦଟି କଣ?

Ans A. କଣ୍ଣ

B. କୂର୍ମ

C. କଣ୍ଣ୍ୟ

D. କର୍ଣ୍ଣ

Question Type : MCQ
Question ID : 4410091194277
Option 1 ID : 4410094711022
Option 2 ID : 4410094711023
Option 3 ID : 4410094711024
Option 4 ID : 4410094711025

Status : Answered
Chosen Option : D

Q.6
8

ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

I will accompany you even if I am tired.

Ans A. ମୁଁ  ହାଲିଆ ହେଲେ ବି ତୁ ମ ସାଙ୍ଗରେ ଯାଇଛି।

B. ମୁଁ  ହାଲିଆ ହେଲେ ବି ତୁ ମ ସାଙ୍ଗରେ ଗଲି।

C. ମୁଁ  ହାଲିଆ ହେଲେ ବି ତୁ ମ ସାଙ୍ଗରେ ଯାଉଥି ଲି।

D. ମୁଁ  ହାଲିଆ ହେଲେ ବି ତୁ ମ ସାଙ୍ଗରେ ଯିବି।

Question Type : MCQ
Question ID : 4410091233134
Option 1 ID : 4410094866236
Option 2 ID : 4410094866237
Option 3 ID : 4410094866234
Option 4 ID : 4410094866235

Status : Answered
Chosen Option : D

Q.6
9

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।

ଉନ୍ନତି

Ans A. ଅବନତି

B. ପ୍ରଗତି

C. ବିସ୍ତାର

D. ଅଭିବୃଦ୍ଧି

Question Type : MCQ
Question ID : 4410091081143
Option 1 ID : 4410094261757
Option 2 ID : 4410094261754
Option 3 ID : 4410094261755
Option 4 ID : 4410094261756

Status : Answered
Chosen Option : A
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Q.7
0

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।

ଅମୃତ

Ans A. ଗରଳ

B. ପୀୟୁ ଷ

C. ଜାଂଗୁଳ

D. ବିଷ

Question Type : MCQ
Question ID : 4410091080873
Option 1 ID : 4410094260709
Option 2 ID : 4410094260706
Option 3 ID : 4410094260708
Option 4 ID : 4410094260707

Status : Answered
Chosen Option : B

Q.7
1

______ ମୁଁ  ବହୁତ ବ୍ୟସ୍ତ ଥିଲି ______ ମୁଁ  ବାପା ଦେଇଥିବା କାମଟା ସମୟ ଭିତରେ ଶେଷ କରିପାରିଲି।

Ans A. ଯଦିଓ, ତଥାପି

B. କାରଣ, ବା

C. ଯଦି, ତେବେ

D. ଏବଂ, ଓ

Question Type : MCQ
Question ID : 4410091675388
Option 1 ID : 4410096610693
Option 2 ID : 4410096610695
Option 3 ID : 4410096610692
Option 4 ID : 4410096610694

Status : Answered
Chosen Option : A

Q.7
2

କିଛି ଶବ୍ଦ ଭୁ ଲ ଲେଖା ହୋଇଥିବା ଏକ ବାକ୍ୟ ଦିଆଯାଇଛି। ବିକଳ୍ପ ଗୁଡିକରୁ  ଗୋଟିଏ ବାଛନ୍ତୁ, ଯେଉଁ ଥିରେ କୌଣସି
ବନାନ ତ୍ରୁଟି ନାହିଁ।

ସାମ୍ପ୍ରତିକ ବର୍ଷ ଗୁଡିକରେ, ଅକ୍ଷୟ ଶକ୍ତିର ବ୍ୟବହାର ଯଥେଷ୍ଟ ବୃଦ୍ଧି ପାଇଛି

Ans A. ସାମ୍ପ୍ରତିକ ବର୍ଶ ଗୁଡିକରେ ଅକ୍ଷୟ ସକ୍ତିର ବ୍ୟବହାର ଯଥେଷ୍ଟ ବୃଧୀ ପାଇଛି|

B. ସାମ୍ପ୍ରତିକ ବର୍ଷ ଗୁଡିକରେ ଅକ୍ଷୟ ଶକ୍ତିର ବ୍ୟବହାର ଯଥେଷ୍ଟ ବୃଦ୍ଧି ପାଇଛି|

C. ସାମ୍ପ୍ରତିକ ବର୍ଷ ଗୁଡିକରେ ଅକ୍ଷୟ ଷକ୍ତିର ବ୍ୟବହାର ଯଥେଷ୍ଟ ବୃଦ୍ଧି ପାଇଛୀ|

D. ସାମ୍ପ୍ରତିକ ବର୍ସ ଗୁଡୀକରେ ଅକ୍ଷୟ ଶକ୍ତିର ବ୍ୟବହାର ଯଥେଷ୍ଟ ବୃଦ୍ଧି ପାଇଛି|

Question Type : MCQ
Question ID : 4410091236289
Option 1 ID : 4410094878737
Option 2 ID : 4410094878740
Option 3 ID : 4410094878739
Option 4 ID : 4410094878738

Status : Answered
Chosen Option : B
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Q.7
3

ନିମ୍ନଲିଖିତ ବିକଳ୍ପଗୁଡ଼ିକ ମଧ୍ୟରୁ  ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସଠିକ୍ ଇଂରାଜୀ ଅନୁବାଦ ବାଛନ୍ତୁ:
ଭାରତର ଅର୍ଥନୀତି ଦ୍ରୁତଗତିରେ ବିକଶିତ ହେଉଛି।

Ans A. The Indian economy was growing tomorrow.

B. The Indian economy will grow yesterday.

C. The Indian economy is growing rapidly.

D. The Indian economy has grown yesterday.

Question Type : MCQ
Question ID : 4410091201700
Option 1 ID : 4410094740587
Option 2 ID : 4410094740586
Option 3 ID : 4410094740584
Option 4 ID : 4410094740585

Status : Answered
Chosen Option : C

Q.7
4

ଜଳ ______ ପଡୁ ଛି ।

Ans A. ଝରୁ ଛି

B. ବିନ୍ଦୁ ବିନ୍ଦୁ

C. ଥର ଥର

D. ଶୀଘ୍ର

Question Type : MCQ
Question ID : 4410091675747
Option 1 ID : 4410096611826
Option 2 ID : 4410096611825
Option 3 ID : 4410096611824
Option 4 ID : 4410096611827

Status : Answered
Chosen Option : B

Q.7
5

ମୁଁ  ତାଙ୍କୁ ଅନେକ ଥର ଫୋନ୍ କଲି, ______ ସେ ଉତ୍ତର ଦେଲେ ନାହିଁ।

Ans A. ଯେହେତୁ

B. କିନ୍ତୁ

C. ଏବଂ

D. କାରଣ

Question Type : MCQ
Question ID : 4410091675412
Option 1 ID : 4410096610788
Option 2 ID : 4410096610790
Option 3 ID : 4410096610791
Option 4 ID : 4410096610789

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସାଧାରଣ ମନୁଷ୍ୟ ସବୁବେଳେ ଅନୁକୂଳ ଅବସ୍ଥାକୁ ଲକ୍ଷ୍ୟ କରି ରହେ । ନିଜର ଇଚ୍ଛାନୁଯାୟୀ ବେଷ୍ଟନୀଟିଏ ପାଇଲେ ସେ
ଆନନ୍ଦ ଅନୁଭବ କରେ । ଜଗତ୍  ସହିତ ତାର ସମ୍ପର୍କ ସଂଶ୍ଲିଷ୍ଟ ହୁଏ, ଗୋଟାଏ ସ୍ୱାର୍ଥଜଡ଼ିତ ଦିଗରେ। ସେ ଅନ୍ୟ କୌଣସି
ବିଷୟରେ ବିଶେଷ ଆସ୍ଥା ସ୍ଥାପନ କରେ ନାହିଁ । ତାର ବେଷ୍ଟନୀଟି ଏପରି ଗଢ଼ି ହୋଇ ଉଠେ ଯେ, ଦୃଷ୍ଟି  ସଞ୍ଚାଳନ କରିବାକୁ
ତାକୁ ଗୋଟାଏ ଦିଗରେ ଅବସର ମିଳେ । ସାଂସାରିକ କାର୍ଯ୍ୟ ସମ୍ପାଦନରେ ଏପରି ଏକଦେଶଦର୍ଶୀ ହେବା ସମୀଚୀନ
ହୋଇପାରେ; କିନ୍ତୁ ଯେଉଁ ମାନଙ୍କର ଚିନ୍ତାଧାରା ପ୍ରଚଳିତ ରୀତକୁ ଅତିକ୍ରମ କରେ, ସେମାନଙ୍କର କାର୍ଯ୍ୟ ପ୍ରଣାଳୀରେ ଗୋଟାଏ
ନୂତନତ୍  ଲକ୍ଷିତ ହୁଏ । ସେମାନେ ଯେଉଁ  ପାରିପାର୍ଶ୍ବକ ଅବସ୍ଥା ସୃଷ୍ଟି  କରନ୍ତି, ତାହା ସାଧାରଣ ସାଂସାରିକ ଜୀବନର ବିରୋଧୀ
ହୁଏ । ଏହି ବିରୁ ଦ୍ଧ ବେଷ୍ଟନୀ ସଂସାରୀର ବୋଧଗମ୍ୟ ହୁଏ ନାହିଁ; ତେଣୁ ମହତ୍  ଲୋକର କାର୍ଯ୍ୟ ସହଜରେ ଅନୁସୃତ
ହୋଇପାରେ ନାହିଁ । ବେଗବତୀ ନଦୀର ପ୍ରବଳ ପ୍ରବାହ ଅନନ୍ତ ସାଗର ସଙ୍ଗମରେ ଗୋଟାଏ ବିରାଟ ସମାନତା ସୃଷ୍ଟି  କରେ;
କିନ୍ତୁ ସମୟ ସମୟରେ ଯେଉଁ  ଉତ୍ତାଳ ଜଳ- କଲ୍ଲୋଳ ଉଠେ, ତାହା ସେହି ସମତାକୁ ଲୋପ କରିଦିଏ। ଜୀବନର ଧାରାବାହିକ
ପର୍ଯ୍ୟାୟରେ ଯେତେବେଳେ ଜଡ଼ତା ଆସେ, ସେତେବେଳେ ପ୍ରାକୃତିକ ନିୟମକୁ ଅନୁସରଣ କରି ଗୋଟାଏ ସ୍ପନ୍ଦନ ହୁଏ । ଏହି
ସ୍ପନ୍ଦନକୁ କେହି କେହି ଅସ୍ଵାଭାବିକ ବୋଲି ମନେ କରି ପାରନ୍ତି; କିନ୍ତୁ ଜଗତରେ କୌଣସି ଘଟନା ଅନାହୂତ ଭାବରେ ସଙ୍ଘଟିତ
ହୁଏ ନାହିଁ । ଶାନ୍ତ ବାୟୁ ମଣ୍ଡଳ ପ୍ରଖର ସୂର୍ଯ୍ୟକିରଣ ପ୍ରଭାବରେ ପ୍ରବଳ ଝଡ଼ ସୃଷ୍ଟି  କରେ। ଜାଗତିକ କାର୍ଯ୍ୟ ସବୁବେଳେ ଗୋଟିଏ
ରୀତିରେ ଆଚରିତ ହୁଏ ନାହିଁ । କାଳର ପ୍ରଭାବ ସଙ୍ଗେ ମନୀଷୀମାନଙ୍କର ପ୍ରେରଣା ମିଶି ଗୋଟାଏ ନୂତନତ୍ୱ ସୃଷ୍ଟି  କରେ ।
ଏହାକୁ ସାଧାରଣତଃ ଆମ୍ଭେମାନେ ଯୁଗୋଚିତ ପରିବର୍ତ୍ତନ ଆଖ୍ୟା ଦେଇଥାଉଁ  ।

SubQuestion No : 76

Q.7
6

ଅନୁଚ୍ଛେଦର ଗଢଣ କେମିତି?

Ans A. ନିଜ ମତମତ ମାତ୍ର ପ୍ରଦର୍ଶନ କରିଛି

B. କାର୍ଯ୍ୟକୁ କ୍ରମିକ ଭାବରେ ବିବେଚନା କରିଛି

C. କେବଳ ନିଜ ଅନୁଭୂ ତି ବର୍ଣ୍ଣନା କରିଛି

D. ଇତିହାସ ଓ ଘଟଣା ବିବରଣୀ ମିଶାଇଛି

Question Type : MCQ
Question ID : 4410091482688
Option 1 ID : 4410095857740
Option 2 ID : 4410095857737
Option 3 ID : 4410095857738
Option 4 ID : 4410095857739

Status : Answered
Chosen Option : B
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସାଧାରଣ ମନୁଷ୍ୟ ସବୁବେଳେ ଅନୁକୂଳ ଅବସ୍ଥାକୁ ଲକ୍ଷ୍ୟ କରି ରହେ । ନିଜର ଇଚ୍ଛାନୁଯାୟୀ ବେଷ୍ଟନୀଟିଏ ପାଇଲେ ସେ
ଆନନ୍ଦ ଅନୁଭବ କରେ । ଜଗତ୍  ସହିତ ତାର ସମ୍ପର୍କ ସଂଶ୍ଲିଷ୍ଟ ହୁଏ, ଗୋଟାଏ ସ୍ୱାର୍ଥଜଡ଼ିତ ଦିଗରେ। ସେ ଅନ୍ୟ କୌଣସି
ବିଷୟରେ ବିଶେଷ ଆସ୍ଥା ସ୍ଥାପନ କରେ ନାହିଁ । ତାର ବେଷ୍ଟନୀଟି ଏପରି ଗଢ଼ି ହୋଇ ଉଠେ ଯେ, ଦୃଷ୍ଟି  ସଞ୍ଚାଳନ କରିବାକୁ
ତାକୁ ଗୋଟାଏ ଦିଗରେ ଅବସର ମିଳେ । ସାଂସାରିକ କାର୍ଯ୍ୟ ସମ୍ପାଦନରେ ଏପରି ଏକଦେଶଦର୍ଶୀ ହେବା ସମୀଚୀନ
ହୋଇପାରେ; କିନ୍ତୁ ଯେଉଁ ମାନଙ୍କର ଚିନ୍ତାଧାରା ପ୍ରଚଳିତ ରୀତକୁ ଅତିକ୍ରମ କରେ, ସେମାନଙ୍କର କାର୍ଯ୍ୟ ପ୍ରଣାଳୀରେ ଗୋଟାଏ
ନୂତନତ୍  ଲକ୍ଷିତ ହୁଏ । ସେମାନେ ଯେଉଁ  ପାରିପାର୍ଶ୍ବକ ଅବସ୍ଥା ସୃଷ୍ଟି  କରନ୍ତି, ତାହା ସାଧାରଣ ସାଂସାରିକ ଜୀବନର ବିରୋଧୀ
ହୁଏ । ଏହି ବିରୁ ଦ୍ଧ ବେଷ୍ଟନୀ ସଂସାରୀର ବୋଧଗମ୍ୟ ହୁଏ ନାହିଁ; ତେଣୁ ମହତ୍  ଲୋକର କାର୍ଯ୍ୟ ସହଜରେ ଅନୁସୃତ
ହୋଇପାରେ ନାହିଁ । ବେଗବତୀ ନଦୀର ପ୍ରବଳ ପ୍ରବାହ ଅନନ୍ତ ସାଗର ସଙ୍ଗମରେ ଗୋଟାଏ ବିରାଟ ସମାନତା ସୃଷ୍ଟି  କରେ;
କିନ୍ତୁ ସମୟ ସମୟରେ ଯେଉଁ  ଉତ୍ତାଳ ଜଳ- କଲ୍ଲୋଳ ଉଠେ, ତାହା ସେହି ସମତାକୁ ଲୋପ କରିଦିଏ। ଜୀବନର ଧାରାବାହିକ
ପର୍ଯ୍ୟାୟରେ ଯେତେବେଳେ ଜଡ଼ତା ଆସେ, ସେତେବେଳେ ପ୍ରାକୃତିକ ନିୟମକୁ ଅନୁସରଣ କରି ଗୋଟାଏ ସ୍ପନ୍ଦନ ହୁଏ । ଏହି
ସ୍ପନ୍ଦନକୁ କେହି କେହି ଅସ୍ଵାଭାବିକ ବୋଲି ମନେ କରି ପାରନ୍ତି; କିନ୍ତୁ ଜଗତରେ କୌଣସି ଘଟନା ଅନାହୂତ ଭାବରେ ସଙ୍ଘଟିତ
ହୁଏ ନାହିଁ । ଶାନ୍ତ ବାୟୁ ମଣ୍ଡଳ ପ୍ରଖର ସୂର୍ଯ୍ୟକିରଣ ପ୍ରଭାବରେ ପ୍ରବଳ ଝଡ଼ ସୃଷ୍ଟି  କରେ। ଜାଗତିକ କାର୍ଯ୍ୟ ସବୁବେଳେ ଗୋଟିଏ
ରୀତିରେ ଆଚରିତ ହୁଏ ନାହିଁ । କାଳର ପ୍ରଭାବ ସଙ୍ଗେ ମନୀଷୀମାନଙ୍କର ପ୍ରେରଣା ମିଶି ଗୋଟାଏ ନୂତନତ୍ୱ ସୃଷ୍ଟି  କରେ ।
ଏହାକୁ ସାଧାରଣତଃ ଆମ୍ଭେମାନେ ଯୁଗୋଚିତ ପରିବର୍ତ୍ତନ ଆଖ୍ୟା ଦେଇଥାଉଁ  ।

SubQuestion No : 77

Q.7
7

ଅନୁଚ୍ଛେଦରୁ  କ’ଣ ଅନୁମାନ କରାଯାଇପାରିବ?

Ans A. ସବୁବେଳେ ଅସ୍ୱାଭାବିକ ଘଟଣା ଘଟେ

B. କୌଣସି କ୍ରମ ନଥାଏ

C. ମନୁଷ୍ୟଙ୍କ କାର୍ଯ୍ୟ ପ୍ରାକୃତିକ ନିୟମ ସହିତ ସମ୍ବନ୍ଧିତ

D. ସମସ୍ତ କାର୍ଯ୍ୟ ଏକରୂ ପ ଭାବେ ଘଟେ

Question Type : MCQ
Question ID : 4410091482689
Option 1 ID : 4410095857743
Option 2 ID : 4410095857744
Option 3 ID : 4410095857742
Option 4 ID : 4410095857741

Status : Answered
Chosen Option : C
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସାଧାରଣ ମନୁଷ୍ୟ ସବୁବେଳେ ଅନୁକୂଳ ଅବସ୍ଥାକୁ ଲକ୍ଷ୍ୟ କରି ରହେ । ନିଜର ଇଚ୍ଛାନୁଯାୟୀ ବେଷ୍ଟନୀଟିଏ ପାଇଲେ ସେ
ଆନନ୍ଦ ଅନୁଭବ କରେ । ଜଗତ୍  ସହିତ ତାର ସମ୍ପର୍କ ସଂଶ୍ଲିଷ୍ଟ ହୁଏ, ଗୋଟାଏ ସ୍ୱାର୍ଥଜଡ଼ିତ ଦିଗରେ। ସେ ଅନ୍ୟ କୌଣସି
ବିଷୟରେ ବିଶେଷ ଆସ୍ଥା ସ୍ଥାପନ କରେ ନାହିଁ । ତାର ବେଷ୍ଟନୀଟି ଏପରି ଗଢ଼ି ହୋଇ ଉଠେ ଯେ, ଦୃଷ୍ଟି  ସଞ୍ଚାଳନ କରିବାକୁ
ତାକୁ ଗୋଟାଏ ଦିଗରେ ଅବସର ମିଳେ । ସାଂସାରିକ କାର୍ଯ୍ୟ ସମ୍ପାଦନରେ ଏପରି ଏକଦେଶଦର୍ଶୀ ହେବା ସମୀଚୀନ
ହୋଇପାରେ; କିନ୍ତୁ ଯେଉଁ ମାନଙ୍କର ଚିନ୍ତାଧାରା ପ୍ରଚଳିତ ରୀତକୁ ଅତିକ୍ରମ କରେ, ସେମାନଙ୍କର କାର୍ଯ୍ୟ ପ୍ରଣାଳୀରେ ଗୋଟାଏ
ନୂତନତ୍  ଲକ୍ଷିତ ହୁଏ । ସେମାନେ ଯେଉଁ  ପାରିପାର୍ଶ୍ବକ ଅବସ୍ଥା ସୃଷ୍ଟି  କରନ୍ତି, ତାହା ସାଧାରଣ ସାଂସାରିକ ଜୀବନର ବିରୋଧୀ
ହୁଏ । ଏହି ବିରୁ ଦ୍ଧ ବେଷ୍ଟନୀ ସଂସାରୀର ବୋଧଗମ୍ୟ ହୁଏ ନାହିଁ; ତେଣୁ ମହତ୍  ଲୋକର କାର୍ଯ୍ୟ ସହଜରେ ଅନୁସୃତ
ହୋଇପାରେ ନାହିଁ । ବେଗବତୀ ନଦୀର ପ୍ରବଳ ପ୍ରବାହ ଅନନ୍ତ ସାଗର ସଙ୍ଗମରେ ଗୋଟାଏ ବିରାଟ ସମାନତା ସୃଷ୍ଟି  କରେ;
କିନ୍ତୁ ସମୟ ସମୟରେ ଯେଉଁ  ଉତ୍ତାଳ ଜଳ- କଲ୍ଲୋଳ ଉଠେ, ତାହା ସେହି ସମତାକୁ ଲୋପ କରିଦିଏ। ଜୀବନର ଧାରାବାହିକ
ପର୍ଯ୍ୟାୟରେ ଯେତେବେଳେ ଜଡ଼ତା ଆସେ, ସେତେବେଳେ ପ୍ରାକୃତିକ ନିୟମକୁ ଅନୁସରଣ କରି ଗୋଟାଏ ସ୍ପନ୍ଦନ ହୁଏ । ଏହି
ସ୍ପନ୍ଦନକୁ କେହି କେହି ଅସ୍ଵାଭାବିକ ବୋଲି ମନେ କରି ପାରନ୍ତି; କିନ୍ତୁ ଜଗତରେ କୌଣସି ଘଟନା ଅନାହୂତ ଭାବରେ ସଙ୍ଘଟିତ
ହୁଏ ନାହିଁ । ଶାନ୍ତ ବାୟୁ ମଣ୍ଡଳ ପ୍ରଖର ସୂର୍ଯ୍ୟକିରଣ ପ୍ରଭାବରେ ପ୍ରବଳ ଝଡ଼ ସୃଷ୍ଟି  କରେ। ଜାଗତିକ କାର୍ଯ୍ୟ ସବୁବେଳେ ଗୋଟିଏ
ରୀତିରେ ଆଚରିତ ହୁଏ ନାହିଁ । କାଳର ପ୍ରଭାବ ସଙ୍ଗେ ମନୀଷୀମାନଙ୍କର ପ୍ରେରଣା ମିଶି ଗୋଟାଏ ନୂତନତ୍ୱ ସୃଷ୍ଟି  କରେ ।
ଏହାକୁ ସାଧାରଣତଃ ଆମ୍ଭେମାନେ ଯୁଗୋଚିତ ପରିବର୍ତ୍ତନ ଆଖ୍ୟା ଦେଇଥାଉଁ  ।

SubQuestion No : 78

Q.7
8

ଅନୁଚ୍ଛେଦର ସମ୍ପର୍କ ବିଶ୍ୱ ଜୀବନ ସହିତ କେମିତି?

Ans A. ସେହି ସଂଯୋଗ ଉପରେ ଧ୍ୟାନ ନାହିଁ

B. ନିଜ ସଂସ୍କୃ ତି ସହିତ ସଂଯୋଗ

C. ପ୍ରାକୃତିକ ଓ ସାଧାରଣ ଘଟଣାର ସହିତ ସଂଯୋଗ

D. ଏକ ନିର୍ବିକଳ୍ପ ଚିନ୍ତନ

Question Type : MCQ
Question ID : 4410091482690
Option 1 ID : 4410095857748
Option 2 ID : 4410095857746
Option 3 ID : 4410095857745
Option 4 ID : 4410095857747

Status : Answered
Chosen Option : C
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସାଧାରଣ ମନୁଷ୍ୟ ସବୁବେଳେ ଅନୁକୂଳ ଅବସ୍ଥାକୁ ଲକ୍ଷ୍ୟ କରି ରହେ । ନିଜର ଇଚ୍ଛାନୁଯାୟୀ ବେଷ୍ଟନୀଟିଏ ପାଇଲେ ସେ
ଆନନ୍ଦ ଅନୁଭବ କରେ । ଜଗତ୍  ସହିତ ତାର ସମ୍ପର୍କ ସଂଶ୍ଲିଷ୍ଟ ହୁଏ, ଗୋଟାଏ ସ୍ୱାର୍ଥଜଡ଼ିତ ଦିଗରେ। ସେ ଅନ୍ୟ କୌଣସି
ବିଷୟରେ ବିଶେଷ ଆସ୍ଥା ସ୍ଥାପନ କରେ ନାହିଁ । ତାର ବେଷ୍ଟନୀଟି ଏପରି ଗଢ଼ି ହୋଇ ଉଠେ ଯେ, ଦୃଷ୍ଟି  ସଞ୍ଚାଳନ କରିବାକୁ
ତାକୁ ଗୋଟାଏ ଦିଗରେ ଅବସର ମିଳେ । ସାଂସାରିକ କାର୍ଯ୍ୟ ସମ୍ପାଦନରେ ଏପରି ଏକଦେଶଦର୍ଶୀ ହେବା ସମୀଚୀନ
ହୋଇପାରେ; କିନ୍ତୁ ଯେଉଁ ମାନଙ୍କର ଚିନ୍ତାଧାରା ପ୍ରଚଳିତ ରୀତକୁ ଅତିକ୍ରମ କରେ, ସେମାନଙ୍କର କାର୍ଯ୍ୟ ପ୍ରଣାଳୀରେ ଗୋଟାଏ
ନୂତନତ୍  ଲକ୍ଷିତ ହୁଏ । ସେମାନେ ଯେଉଁ  ପାରିପାର୍ଶ୍ବକ ଅବସ୍ଥା ସୃଷ୍ଟି  କରନ୍ତି, ତାହା ସାଧାରଣ ସାଂସାରିକ ଜୀବନର ବିରୋଧୀ
ହୁଏ । ଏହି ବିରୁ ଦ୍ଧ ବେଷ୍ଟନୀ ସଂସାରୀର ବୋଧଗମ୍ୟ ହୁଏ ନାହିଁ; ତେଣୁ ମହତ୍  ଲୋକର କାର୍ଯ୍ୟ ସହଜରେ ଅନୁସୃତ
ହୋଇପାରେ ନାହିଁ । ବେଗବତୀ ନଦୀର ପ୍ରବଳ ପ୍ରବାହ ଅନନ୍ତ ସାଗର ସଙ୍ଗମରେ ଗୋଟାଏ ବିରାଟ ସମାନତା ସୃଷ୍ଟି  କରେ;
କିନ୍ତୁ ସମୟ ସମୟରେ ଯେଉଁ  ଉତ୍ତାଳ ଜଳ- କଲ୍ଲୋଳ ଉଠେ, ତାହା ସେହି ସମତାକୁ ଲୋପ କରିଦିଏ। ଜୀବନର ଧାରାବାହିକ
ପର୍ଯ୍ୟାୟରେ ଯେତେବେଳେ ଜଡ଼ତା ଆସେ, ସେତେବେଳେ ପ୍ରାକୃତିକ ନିୟମକୁ ଅନୁସରଣ କରି ଗୋଟାଏ ସ୍ପନ୍ଦନ ହୁଏ । ଏହି
ସ୍ପନ୍ଦନକୁ କେହି କେହି ଅସ୍ଵାଭାବିକ ବୋଲି ମନେ କରି ପାରନ୍ତି; କିନ୍ତୁ ଜଗତରେ କୌଣସି ଘଟନା ଅନାହୂତ ଭାବରେ ସଙ୍ଘଟିତ
ହୁଏ ନାହିଁ । ଶାନ୍ତ ବାୟୁ ମଣ୍ଡଳ ପ୍ରଖର ସୂର୍ଯ୍ୟକିରଣ ପ୍ରଭାବରେ ପ୍ରବଳ ଝଡ଼ ସୃଷ୍ଟି  କରେ। ଜାଗତିକ କାର୍ଯ୍ୟ ସବୁବେଳେ ଗୋଟିଏ
ରୀତିରେ ଆଚରିତ ହୁଏ ନାହିଁ । କାଳର ପ୍ରଭାବ ସଙ୍ଗେ ମନୀଷୀମାନଙ୍କର ପ୍ରେରଣା ମିଶି ଗୋଟାଏ ନୂତନତ୍ୱ ସୃଷ୍ଟି  କରେ ।
ଏହାକୁ ସାଧାରଣତଃ ଆମ୍ଭେମାନେ ଯୁଗୋଚିତ ପରିବର୍ତ୍ତନ ଆଖ୍ୟା ଦେଇଥାଉଁ  ।

SubQuestion No : 79

Q.7
9

‘ସମୀଚୀନ’ ଶବ୍ଦର ବିପରୀତ ଶବ୍ଦ କ’ଣ?

Ans A. ଅସମୀଚୀନ

B. ଉଚିତ

C. ସଠିକ୍

D. ଯଥାର୍ଥ

Question Type : MCQ
Question ID : 4410091482691
Option 1 ID : 4410095857749
Option 2 ID : 4410095857751
Option 3 ID : 4410095857752
Option 4 ID : 4410095857750

Status : Answered
Chosen Option : A
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Comprehension:

ଦିଆଯାଇଥି ବା ଗଦ୍ୟାଂଶଟି ସାବଧାନରେ ପଢ଼ି, ନିମ୍ନୋ କ୍ତ ପ୍ରଶ୍ନମାନଙ୍କର ସଠିକ ଉତ୍ତର ପ୍ରଦାନ କର।

ସାଧାରଣ ମନୁଷ୍ୟ ସବୁବେଳେ ଅନୁକୂଳ ଅବସ୍ଥାକୁ ଲକ୍ଷ୍ୟ କରି ରହେ । ନିଜର ଇଚ୍ଛାନୁଯାୟୀ ବେଷ୍ଟନୀଟିଏ ପାଇଲେ ସେ
ଆନନ୍ଦ ଅନୁଭବ କରେ । ଜଗତ୍  ସହିତ ତାର ସମ୍ପର୍କ ସଂଶ୍ଲିଷ୍ଟ ହୁଏ, ଗୋଟାଏ ସ୍ୱାର୍ଥଜଡ଼ିତ ଦିଗରେ। ସେ ଅନ୍ୟ କୌଣସି
ବିଷୟରେ ବିଶେଷ ଆସ୍ଥା ସ୍ଥାପନ କରେ ନାହିଁ । ତାର ବେଷ୍ଟନୀଟି ଏପରି ଗଢ଼ି ହୋଇ ଉଠେ ଯେ, ଦୃଷ୍ଟି  ସଞ୍ଚାଳନ କରିବାକୁ
ତାକୁ ଗୋଟାଏ ଦିଗରେ ଅବସର ମିଳେ । ସାଂସାରିକ କାର୍ଯ୍ୟ ସମ୍ପାଦନରେ ଏପରି ଏକଦେଶଦର୍ଶୀ ହେବା ସମୀଚୀନ
ହୋଇପାରେ; କିନ୍ତୁ ଯେଉଁ ମାନଙ୍କର ଚିନ୍ତାଧାରା ପ୍ରଚଳିତ ରୀତକୁ ଅତିକ୍ରମ କରେ, ସେମାନଙ୍କର କାର୍ଯ୍ୟ ପ୍ରଣାଳୀରେ ଗୋଟାଏ
ନୂତନତ୍  ଲକ୍ଷିତ ହୁଏ । ସେମାନେ ଯେଉଁ  ପାରିପାର୍ଶ୍ବକ ଅବସ୍ଥା ସୃଷ୍ଟି  କରନ୍ତି, ତାହା ସାଧାରଣ ସାଂସାରିକ ଜୀବନର ବିରୋଧୀ
ହୁଏ । ଏହି ବିରୁ ଦ୍ଧ ବେଷ୍ଟନୀ ସଂସାରୀର ବୋଧଗମ୍ୟ ହୁଏ ନାହିଁ; ତେଣୁ ମହତ୍  ଲୋକର କାର୍ଯ୍ୟ ସହଜରେ ଅନୁସୃତ
ହୋଇପାରେ ନାହିଁ । ବେଗବତୀ ନଦୀର ପ୍ରବଳ ପ୍ରବାହ ଅନନ୍ତ ସାଗର ସଙ୍ଗମରେ ଗୋଟାଏ ବିରାଟ ସମାନତା ସୃଷ୍ଟି  କରେ;
କିନ୍ତୁ ସମୟ ସମୟରେ ଯେଉଁ  ଉତ୍ତାଳ ଜଳ- କଲ୍ଲୋଳ ଉଠେ, ତାହା ସେହି ସମତାକୁ ଲୋପ କରିଦିଏ। ଜୀବନର ଧାରାବାହିକ
ପର୍ଯ୍ୟାୟରେ ଯେତେବେଳେ ଜଡ଼ତା ଆସେ, ସେତେବେଳେ ପ୍ରାକୃତିକ ନିୟମକୁ ଅନୁସରଣ କରି ଗୋଟାଏ ସ୍ପନ୍ଦନ ହୁଏ । ଏହି
ସ୍ପନ୍ଦନକୁ କେହି କେହି ଅସ୍ଵାଭାବିକ ବୋଲି ମନେ କରି ପାରନ୍ତି; କିନ୍ତୁ ଜଗତରେ କୌଣସି ଘଟନା ଅନାହୂତ ଭାବରେ ସଙ୍ଘଟିତ
ହୁଏ ନାହିଁ । ଶାନ୍ତ ବାୟୁ ମଣ୍ଡଳ ପ୍ରଖର ସୂର୍ଯ୍ୟକିରଣ ପ୍ରଭାବରେ ପ୍ରବଳ ଝଡ଼ ସୃଷ୍ଟି  କରେ। ଜାଗତିକ କାର୍ଯ୍ୟ ସବୁବେଳେ ଗୋଟିଏ
ରୀତିରେ ଆଚରିତ ହୁଏ ନାହିଁ । କାଳର ପ୍ରଭାବ ସଙ୍ଗେ ମନୀଷୀମାନଙ୍କର ପ୍ରେରଣା ମିଶି ଗୋଟାଏ ନୂତନତ୍ୱ ସୃଷ୍ଟି  କରେ ।
ଏହାକୁ ସାଧାରଣତଃ ଆମ୍ଭେମାନେ ଯୁଗୋଚିତ ପରିବର୍ତ୍ତନ ଆଖ୍ୟା ଦେଇଥାଉଁ  ।

SubQuestion No : 80

Q.8
0

‘ଏକଦେଶଦର୍ଶୀ’ ଶବ୍ଦର ଅର୍ଥ କ’ଣ?

Ans A. ଗୋଟିଏ ଦିଗରେ ମାତ୍ର ଦୃଷ୍ଟି  ରଖୁଥି ବା

B. ସବୁ ଦିଗ ଦେଖୁଥି ବା

C. ଅନ୍ଧ ହୋଇଯାଇଥି ବା

D. କୌଣସି ଦିଗ ନ ଦେଖୁଥି ବା

Question Type : MCQ
Question ID : 4410091482692
Option 1 ID : 4410095857754
Option 2 ID : 4410095857753
Option 3 ID : 4410095857756
Option 4 ID : 4410095857755

Status : Answered
Chosen Option : A

Q.8
1

What is meant by Print Preview?

Ans A. Edit text content only

B. Change color of text

C. Enable macros

D. See how the document will look when printed

Question Type : MCQ
Question ID : 4410091450560
Option 1 ID : 4410095730698
Option 2 ID : 4410095730700
Option 3 ID : 4410095730701
Option 4 ID : 4410095730699

Status : Answered
Chosen Option : D

Section : Computer
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Q.8
2

In ascending order sorting, data in MS Excel 2021 is arranged:

Ans A. in a random order

B. from largest to smallest

C. from oldest to newest

D. from smallest to largest

Question Type : MCQ
Question ID : 4410091422181
Option 1 ID : 4410095617616
Option 2 ID : 4410095617614
Option 3 ID : 4410095617617
Option 4 ID : 4410095617615

Status : Answered
Chosen Option : B

Q.8
3

The term USB stands for:

Ans A. Universal System Bus

B. Universal Serial Bus

C. Unique Serial Bus

D. Uniform Standard Bus

Question Type : MCQ
Question ID : 4410091444312
Option 1 ID : 4410095705871
Option 2 ID : 4410095705869
Option 3 ID : 4410095705870
Option 4 ID : 4410095705872

Status : Answered
Chosen Option : B

Q.8
4

In context of file management, match tasks in Column A with their respective methods
in Column B.

Column A Column B
1. Copy a file a) Select the file, right-click, and choose “Rename”

2. Move a file b) Click and drag the file to a new folder or drive

3. Rename a file c) Use “Copy” and then “Paste” in the desired destination folder

4. Delete a file d) Select the file, right-click, and choose “Delete”

Ans A. 1-a, 2-c, 3-d, 4-b

B. 1-c, 2-b, 3-a, 4-d

C. 1-b, 2-a, 3-c, 4-d

D. 1-d, 2-c, 3-b, 4-a

Question Type : MCQ
Question ID : 4410091442709
Option 1 ID : 4410095699420
Option 2 ID : 4410095699419
Option 3 ID : 4410095699421
Option 4 ID : 4410095699422

Status : Answered
Chosen Option : B
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Q.8
5

What is the primary function of the View menu in MS Word?

Ans A. Display the document in different layouts and control visibility of tools

B. Format the text and paragraphs

C. Insert text boxes and images

D. Print the document

Question Type : MCQ
Question ID : 441009941768
Option 1 ID : 4410093720734
Option 2 ID : 4410093720733
Option 3 ID : 4410093720732
Option 4 ID : 4410093720735

Status : Answered
Chosen Option : A

Q.8
6

In a multitasking operating system, the function that isolates process address spaces
to prevent one user program from modifying or accessing another program’s memory
is known as:

Ans A. Process management thread

B. File access controller

C. Job execution handler

D. Memory protection mechanism

Question Type : MCQ
Question ID : 4410091425336
Option 1 ID : 4410095629954
Option 2 ID : 4410095629953
Option 3 ID : 4410095629952
Option 4 ID : 4410095629951

Status : Not Attempted and
Marked For Review

Chosen Option : --

Q.8
7

Which action will sort numbers in a column from largest to smallest in MS Excel?

Ans A. Click Sort & Filter, then choose 'Sort Largest to Smallest'

B. Apply a filter and select only the largest number

C. Use the SUM function on the column

D. Click Sort & Filter, then choose 'Sort Smallest to Largest'

Question Type : MCQ
Question ID : 4410091427853
Option 1 ID : 4410095639944
Option 2 ID : 4410095639946
Option 3 ID : 4410095639947
Option 4 ID : 4410095639945

Status : Answered
Chosen Option : A
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Q.8
8

Which of the following statements best explains the use of Google Docs in data
handling and collaboration?

Ans A. Google Docs allows real-time document creation, editing, and sharing through cloud
storage.

B. Google Docs stores documents only on local drives without online backup.

C. Google Docs is used exclusively for data encryption and network security.

D. Google Docs is a desktop-only word processor that requires manual saving of files.

Question Type : MCQ
Question ID : 4410091477831
Option 1 ID : 4410095838658
Option 2 ID : 4410095838660
Option 3 ID : 4410095838659
Option 4 ID : 4410095838657

Status : Not Attempted and
Marked For Review

Chosen Option : --

Q.8
9

A scanner is an example of a device that performs a necessary conversion: it captures
an image or text from a physical piece of paper and changes it into a digital data format
that can be edited or stored by the computer system. This process of conversion is the
core function of an ________________.

Ans A. input device

B. output device

C. application program

D. internal bus

Question Type : MCQ
Question ID : 4410091411872
Option 1 ID : 4410095576504
Option 2 ID : 4410095576505
Option 3 ID : 4410095576507
Option 4 ID : 4410095576506

Status : Answered
Chosen Option : A

Q.9
0

Where is the option located to quickly access a recently used MS-PowerPoint file?

Ans A. File > New

B. Home tab

C. File > Recent

D. View tab

Question Type : MCQ
Question ID : 4410091426047
Option 1 ID : 4410095632775
Option 2 ID : 4410095632777
Option 3 ID : 4410095632776
Option 4 ID : 4410095632778

Status : Answered
Chosen Option : C

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.9
1

Match the computer generations given in Column A with their primary technological
base in Column B and select the correct option.

Column A Column B
1. 1st Generation a) Based on transistors

2. 2nd Generation b) Based on integrated circuits

3. 3rd Generation c) Based on vacuum tubes

4. 4th Generation d) Based on microprocessors

Ans A. 1-a, 2-c, 3-d, 4-b

B. 1-c, 2-b, 3-d, 4-a

C. 1-c, 2-a, 3-b, 4-d

D. 1-b, 2-d, 3-c, 4-a

Question Type : MCQ
Question ID : 4410091438664
Option 1 ID : 4410095683366
Option 2 ID : 4410095683368
Option 3 ID : 4410095683365
Option 4 ID : 4410095683367

Status : Answered
Chosen Option : C

Q.9
2

Which of the following methods allows you to search for files and folders directly from
the Windows taskbar?

Ans A. Press Ctrl + F while browsing the desktop

B. Use the Control Panel and select the Storage option

C. Open File Explorer and right-click on This PC

D. Type the file name or keyword in the search box on the taskbar

Question Type : MCQ
Question ID : 4410091438086
Option 1 ID : 4410095681044
Option 2 ID : 4410095681043
Option 3 ID : 4410095681041
Option 4 ID : 4410095681042

Status : Answered
Chosen Option : D

Q.9
3

Which is the fastest memory in terms of speed?

Ans A. Cache

B. ROM

C. Pendrive

D. RAM

Question Type : MCQ
Question ID : 4410091436770
Option 1 ID : 4410095675816
Option 2 ID : 4410095675815
Option 3 ID : 4410095675817
Option 4 ID : 4410095675814

Status : Answered
Chosen Option : A
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Q.9
4

Which method is typically used to connect a computer to the Internet?

Ans A. Running offline applications only

B. Transferring files via Bluetooth

C. Using a modem to connect through an Internet Service Provider (ISP)

D. Connecting to a local area network without an ISP

Question Type : MCQ
Question ID : 4410091452880
Option 1 ID : 4410095739845
Option 2 ID : 4410095739844
Option 3 ID : 4410095739843
Option 4 ID : 4410095739842

Status : Answered
Chosen Option : C

Q.9
5

Which dialog box in MS Word 2020 lets you choose font type, size, and styles like bold
or underline?

Ans A. Paragraph Settings

B. Styles Pane

C. Font Dialog Box

D. Format Painter

Question Type : MCQ
Question ID : 4410091447686
Option 1 ID : 4410095719352
Option 2 ID : 4410095719353
Option 3 ID : 4410095719350
Option 4 ID : 4410095719351

Status : Answered
Chosen Option : C

Q.9
6

The “Blank Presentation” option is best used when you want to:

Ans A. View sample slides

B. Create a presentation without any pre-applied theme

C. Import Excel data

D. Use PowerPoint without saving

Question Type : MCQ
Question ID : 4410091450672
Option 1 ID : 4410095731148
Option 2 ID : 4410095731147
Option 3 ID : 4410095731149
Option 4 ID : 4410095731146

Status : Answered
Chosen Option : B
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Q.9
7

Which type of account is used to access services like Google Docs, Calendar, YouTube,
etc.?

Ans A. Google account

B. Microsoft account

C. Database

D. Application based

Question Type : MCQ
Question ID : 4410091447644
Option 1 ID : 4410095719186
Option 2 ID : 4410095719189
Option 3 ID : 4410095719187
Option 4 ID : 4410095719188

Status : Answered
Chosen Option : A

Q.9
8

Deleting a row in a spreadsheet causes:

Ans A. Nothing changes

B. The rows below to shift up

C. The rows above to shift down

D. The columns to shift left

Question Type : MCQ
Question ID : 4410091426038
Option 1 ID : 4410095632742
Option 2 ID : 4410095632739
Option 3 ID : 4410095632740
Option 4 ID : 4410095632741

Status : Answered
Chosen Option : B

Q.9
9

Which service is a specialized feature of the internet that allows you to have a live,
audio and video conversation with another person or a group, typically using a
webcam and microphone?

Ans A. Video Conferencing

B. File Transfer Protocol (FTP)

C. World Wide Web (WWW)

D. Electronic Mail (Email)

Question Type : MCQ
Question ID : 4410091445229
Option 1 ID : 4410095709491
Option 2 ID : 4410095709490
Option 3 ID : 4410095709492
Option 4 ID : 4410095709489

Status : Answered
Chosen Option : A
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Q.1
00

Which option is used to open an existing MS PowerPoint presentation?

Ans A. File → New

B. File → Open

C. View → Slide Sorter

D. Home → Insert

Question Type : MCQ
Question ID : 4410091448857
Option 1 ID : 4410095723884
Option 2 ID : 4410095723885
Option 3 ID : 4410095723887
Option 4 ID : 4410095723886

Status : Answered
Chosen Option : B
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